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The Quality Management System ISO9001:2008 is approved for the design, manufacture 

and maintenance of all the measuring instrumentation manufactured by Sonel S.A. 

Due to a policy of continuous development of our products, Sonel S.A. reserves the right 

to make changes and improvements on the Thermal Imager and the Thermo Analyze 

software described in this manual without prior notice. 
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©  Sonel S.A., 2010. All rights reserved. This manual must not, in whole or part, be repro-

duced, transmitted or translated into any language in any form or by any means, electron-

ic, magnetic, optical, manual or otherwise, without the prior written permission of Sonel 
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1 Introduction  
 

This publication provides the necessary information required to use the PC software Sonel 

ThermoAnalyze ® to analyze static image files or real-time video taken by thermal camera 

of SONEL S.A. 

It is recommended that this user manual and the thermal camera’s user manual are read 

thoroughly before using the software.   

It is also advisable that all user manuals and instruction leaflets supplied are kept readily 

available for reference, when the software is in general use. 

 

 

Technical Support 

Technical support for the software can be obtained on weekdays, from 7 a.m. to 3 p.m., 

by either contacting the telephone number +48 74 8583860, or by email to the following 

address: hx@sonel.pl   

 

 

Feedback to Us 

From our side we guarantee to make every effort to ensure proper operation of the 

equipment and the software. In case of any changes, related to continuous development 

of our products, information on the changes will be available on our website 

www.en.sonel.pl. Additionally, you are appreciated to let us know about any error you find, 

and your suggestions for further editions by writing an email to the following address: 

hx@sonel.pl. 
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2   Installing Sonel ThermoAnalyze 
 

System requirements 

Operating system: Window 2000 or higher (Windows2000, WindowsXP, WindowsVista),  

Internet Explorer 5.0 (or higher) 

Software: Microsoft® Office 2000 or higher ( Microsoft® Office 2000, Microsoft® Office XP, 

Microsoft® Office 2003, Microsoft® Office 2007 

 

Minimum hardware requirement:  
 
Processor 

 
Pentium3 1GHz  

 
RAM 

 
256MB (512MB recommended) 

 
Free available space on hard disk drive 

 
100MB 

 
Display 

Super VGA (800 x 600) or higher; or higher reso-
lution monitor with 16-bit colors 

 
It is recommended that you close down all applications before installing the program. 
 
 

Driver Installation Guide 

It is recommended to install driver before connecting thermal camera to PC. After insert-

ing the CD containing the driver (supplied with your camera) into CD-ROM drive, installa-

tion dialog box will appear. If the installation box doesn’t appear automatically, double-

click “autorun.exe” file in the CD’s main folder. After selecting language new dialog box 

will appear.  Choose “thermal cameras” and then “install driver”: 
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Choose the type of driver, depending on the operating system installed on your computer 
(32 or 64 bit) 

 
If the camera was connected to your computer before installing the driver, or the original 

installation CD is missing, you can perform installation process manually, using previously 

obtained driver (e.g. by downloading it form our website www.en.sonel.pl). After connect-

ing the camera to USB port in your computer, new Sonel IR device Installer will appear. 

Installer will ask you whether to search for new driver online or not, you need to select “no, 

not this time” option and click “next”. Then allow searching for the drivers automatically – 

the installer will search for the drivers through all data carriers:  

 

 

http://www.en.sonel.pl/
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If the driver is not found automatically choose “Install from a list or specific location (ad-

vanced)”   

 

 

Next use the browser to point the folder (drive) containing driver file, and click next to pro-

ceed 

 

Installation begins. After reaching the stage shown below, choose „ continue anyway”: 
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Dialog box will inform you that the installation process is finished. Click “finish” button.  

 
 

Sonel ThermoAnalyze Install Guide 

It is recommended to close down all applications before installing the program. After in-

serting the CD containing the software (supplied with your camera) into CD-ROM drive, 

installation dialog box will appear. If the installation box doesn’t appear automatically, 

double-click “autorun.exe” file in the CD’s main folder. After selecting language new dialog 

box will appear.  Choose “thermal cameras” and then “install ThermoAnalyze”: 

 

 
 

Installation process will begin, follow the on-screen instructions.  

NOTE: Without changing the default directory to install the program, the installation pro-

cedure will allow the program to be installed under C: \Program files\ 

Sonel ThermoAnalyze. The installation procedure will add a shortcut icon Launch Sonel 

ThermoAnalyze to the Desktop and Start menu.  
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Uninstall Sonel ThermoAnalyze 

Proceed similarly as in the case of installation; after dialog box appears choose “re-

move…” option.  
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3 Using Sonel ThermoAnalyze 

3.1 Choosing a language for Sonel ThermoAnalyze 

After you install the program in your PC and run the program, the program will open with 

the default language. The default language is usually the one used by your operating sys-

tem.  

To change the language, go to Language command under View menu and then choose a 

language you need.  

A checkmark √ will appear in front of the selected language.  

After choosing the language, the program will prompt you to restart it or keep the program 

running with the previously selected language. In order to confirm the language you need 

to restart the program.   

 

3.2 Get to know Sonel ThermoAnalyze interface 

The program has only one Windows-based interface.  

After starting the program, the program interface below will appear. It consists of seven 

parts:  Menu bar, Toolbar, Palette bar, Information bar, DataView bar, Gauge bar and Sta-

tus bar. Below please find detailed introduction to each part.  

 

3.2.1 Menu Bar 

Menu bar consists of eight sub-menu options, including File, Image, Filter, Measure, 

Tools, View, Window and Help. 

 

 
 

Keep left button of the mouse pressed and moving the mouse will allow you to move the 

menu bar to any desired place.   
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Note: Number of sub-menu options depends on the current mode (Thermogram, IR video, 

Report). 

 

3.2.2 Toolbar 

The toolbar is displayed across the top of the program window, below the menu bar. The 

toolbar provides quick one-click mouse access to major functions in the program: 

 
Keep the left button of mouse pressed over the left edge of the toolbar and moving the 

mouse will allow you to move the toolbar to any place. 

Note: To hide or display the toolbar, click Toolbar in the View menu. 

 

3.2.3 Palette Bar 

There are nine palettes available. Moving the mouse across them will accordingly change 

colors of the current opened image file and gauge color. Clicking on a certain palette to 

confirm the selection. Move the mouse out of them without clicking a certain one, the  

opened image file will still be in the original color.   

 
Keep left mouse button pressed and moving the mouse will allow you to move the palette 

bar to any desired place. 

Note: To hide or display the palette bar, click Palette Bar in the View menu or click the 

shortcut  in the toolbar of View menu 

 

3.2.4 Information Bar 

Display information of the opened image file, such as emissivity, humidity, date and time 

when it was created.  

While moving the mouse within the image file, coordinates and temperature of the image 

pixel where the mouse lies will be displayed in the Information bar. 
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Note: 

- To display or hide the information bar, click the Information Bar in the View menu.  

- Clicking  on the right top of the information bar can hide Information Bar as 

well.  

3.2.5 DataView Bar 

Display temperature measurement result of analyzed objects (spots, lines, circles, rectan-

gles, polygons, or delta-two spots) added to the opened image file if any.  

 

 

Keep left mouse button pressed and moving the mouse will allow you to move the Data-

View bar to any desired place.  
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Note:  

- To display or hide the DataView bar, click DataView Bar in the View menu.  

- Clicking  on the right top of the DataView bar can hide the DataView bar as 

well. 

 

3.2.6 Gauge Bar 

 

It displays different colors according the different temperature. 

 

 
 

Note: To hide or display the gauge bar, click Gauge Bar in the View menu.  

 

3.2.7 Status Bar 

The status bar is displayed at the bottom of the program window.  

The left area of the status bar describes actions of menu items as you use the up and 

down arrow keys to navigate through menus. This area similarly shows messages that 

describe the actions of toolbar buttons as you press them, before releasing them. If after 

viewing the description of the toolbar button command you wish not to execute the com-

mand, then release the mouse button while the mouse pointer is off the toolbar button.  

 

 
 

Note: To display or hide the status bar, use the Status Bar command in the View menu. 
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3.3 Use Commands under Menu Bar 

3.3.1 File Menu  

Open Command  

Use this command to open an existing infrared image file in a new window. You can open 

multiple image files at one time. Switching active window is done by mouse click over the 

window or by using “window” menu.  

Note:  

- Clicking shortcut  in the toolbar will open an existing image file as well. 

- 12 images can be opened at a time 

- File name is displayed on the title bar of the opened image file window.  

   

Save Command 

Use this command to save an opened image file along with all analysis elements added 

during analysis process.  

Note:  

- If the opened image file is in IMG format, a prompt whether to save it into IRI format 

will appear before saving it. 

- You have to save the IMG file as IRI format, then the analysis result can be saved into 

the file together. The analysis information can’t be saved in IMG image files 

- If the opened image file is in JPG format, the analysis result and the JPG file will be 

saved together in JPG format. 

- Clicking shortcut  in the toolbar will save opened image file as well. 

  

Save Image as Command 

Use this command to save the opened image file with pallet or without pallet in JPEG or  

BMP image file. 

Note:  

 You cannot measure temperature of pixels in the re-saved BMP or JPG image files 

 To save the visual image of the current infrared image, please select the visual image 

firstly and then click the right mouse button, a menu of “Copy, Save as, Close” will 

appear. Selecting “ Copy” will copy the visual picture to other document, Selecting “ 

Save as” will save the visual picture as another BMP or JPG file, Selecting “ Close” 

will close the visual picture 

Close Command 

Use this command to close opened image file without saving. 

 

Setup Command  

Use this command to set a directory on the hard disks to store infrared images, reports, 

report templates and time format displayed in the information bar.  
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After saving the setup, the program will automatically go to the directory when opening in-

frared images or reports and when creating reports using the Report Wizard.   

 

Report Command  

This command includes following sub-commands: “Word”, “Excel” and “Freport””  

“Word” includes three sub-commands as follows: 

New: Use this command to create a Microsoft® Word (program overlay – you must have 

Microsoft® Word installed on your computer) report with the program for the currently 

opened image file; 

Open: Use this command to open an existing Microsoft® Excel report 

Report Wizard: Use this command to create a Microsoft® Word report step-by-step for 

the currently opened image file 

“Excel” includes two sub-commands as follows: 

New: Use this command to create a Microsoft® Excel (program overlay – you must have 

Microsoft® Excel installed on your computer) report with the program for the currently 

opened image file; 

Open: Use this command to open an existing Microsoft® Excel report 

Freport: Use this command to create a report using internal file format.  

Note: The command “Report wizard” is only available after opening at least one infrared 

image file.  

External Device Manager command 

Using this command can delete image files saved in KT-160 or download them from the 

camera to your PC. If the camera's USB driver (can be found on the supplied CD) is in-

stalled on your computer, choosing this command will open a window allowing you to copy 

thermal images stored in the internal memory of the camera to your hard disk drive, or de-

lete all files from the memory. To make this command active, the camera must be set to 

internal memory (Uflash), or the external memory card must be extracted. The camera 

must be switched on before running the software. 
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Get file from……to: Appoint the file range as per file numbers which will be transferred to 

PC.PC store directory: Appoint store directory for the files to be saved. Click Read button 

to transfer files to PC. Clicking Delete ALL button will remove all the image files from the 

built-in flash memory of the camera. Click Close button to exit the window.  

Note: Transferring files via USB can take several minutes.  

Exit Command 

Use this command to end your Sonel ThermoAnalyze session. After choosing this com-

mand, the program will prompt you to save changes made to opened image files.  

 

3.3.2 Image Menu 

„Palette” command 

Use this command to choose a palette from the nine available for the opened infrared im-

age file.  

Note: this function is also available in previously described Pallete Bar window 

 

„Rotate” command 

This command includes two sub-commands: 

90 CW: 90 degree clockwise rotation of the opened image : 

   

90 CCW : 90 degree counterclockwise rotation of the opened image : 
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“Mirror” command  

This command includes two sub-commands: 

”horizontal”: Use this command to get horizontally mirrored image of the opened image: 

   
“vertical”: Use this command to get vertically mirrored image of the opened image:  

   

“Zoom” command 

This command includes eight sub-commands: 

50%: zoom out opened image by half its original size.  

100%: restore the original size of the image.  

150%: zoom in opened image to150% of its original size.  

200%: zoom in opened image to 200% of its original size. 

300%: zoom in opened image to 300% of its original size. 

400%: zoom in opened image to 400% of its original size. 

500%: zoom in opened image to 500% of its original size. 

Custom: self-defined zoom coefficient  

 

“Zoom In” command 

Zoom in opened image sequentially to: 

100%→150%→200%→300%→400%→500%......→1000%   

This function is also available by pressing  button on toolbar menu 

“Zoom out” command 

Zoom out opened image sequentially to: 
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1000%→900%→800%.......150%→100%→50%  

This function is also available by pressing  button on toolbar menu 

 

“Hand” command 

Allows to move the visible part of the image within the window. Press the left mouse but-

ton, while having the cursor over the image and move the mouse while keeping the 

mouse button pressed.    

 

“Actual Size” command 

Resume the original size of the image 

 

“Gauge setting” command 

Switch on/off the possibility of graphical representation of temperature for every infrared 

image. After switching it on, temperature range bar will pop-up, as shown below:  

 

The red line below colorful bar shows the temperature range registered in the infrared im-

age.   

By moving the two slides we define the temperature range that will be represented by the 

colors displayed on the bar. By pressing “Auto” button, you can also use auto mode,. 

Press “Cancel” to restore original settings and to get back to manual mode.    

Note:  

- You can also switch on/of the temperature range bar by double clicking on infra-

red image.  

- When the gauge scale is adjusted, you can not change the palette.   

 

“Image Fusion” mode 

Set the infrared image and visual image in fusion 

 

After selecting Image Fusion option, you can decrease transparency of the infrared image 

by moving the slide from VL to IR position. 
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The size and position of the thermal image in relation to the visual image can be adjusted 

by grabbing and dragging (holding down the cursor) thermal image window by using the 

"Zoom +" and "Zoom -" buttons. Rotate Angle command allows you to rotate thermal im-

age if needed.  

In Fusion Mode you can lay infrared image over visual image only for the specified tem-

perature range. You can adjust this range with "Low - High" slider, as shown on the image 

below 

 

 

Gauge Advance Setting Command 

 

This command establishes a mapping function for temperature and brightness of each 

image file. 

Type in the max and min temperature in the dialog box, or set the temperatures by press-

ing arrow buttons, to define the temperature range, as shown on the image below:  

 

If multi images are opened, Selecting Apply to all image will apply the temperature setting 

to all opened image files. The command is useful if user wants to compare similar thermal 
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images. User just sets a temperature range and applies to all the images, then, the differ-

ence between each image is easily found.  

  

“Play Sound” Command 

Use this command to play voice annotation saved with the opened image file if any. 

 

Note:  

- This command is only available for files with voice annotation stored.  

- Clicking shortcut  in the toolbar will activate this command as well. The shortcut is 

only available for files with voice annotation stored. 

 

Property Command 

This command allows to display and change properties of the opened image file. Click OK 

button to save changes. 

 

Note:  

- Filter: It reflects camera lens if additional lens is used.     

- Emissivity: It reflects emissivity coefficient value that was set in the infrared camera 

while taking infrared pictures. If you change it here, the image temperature will also 

be changed. When adjusting emissivity coefficient value you must also remember to 

set proper background (ambient) temperature value. 

 

3.3.3 “Filter” Menu 

A set of commands allowing to process thermal image: 

 

Blur:  
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Emboss: 

   

Gaussian:  

   

Soften: 

   

Sharpen: 

   

Edge: 

   

Median: 

   

Add noise: 
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Erode: 

   

Dilate: 

   

Contour: 

   

Jitter: 

   
 

3.3.4 “Measure” Menu 

 

“Temp Unit” mode 

Choose Celsius degrees or Fahrenheit degrees for temperature reading of the opened 

image file. You can switch between these units at any time. All the image temperature 

readings will change accordingly to selected units.  

 

“Show Max/Min Temp Pos” mode 

Indicates where the pixel with the Max /Min temperature lies in the opened image file. Af-

ter selecting this command, Min/Max symbol will show up on the image, pointing the spot 

of the highest (lowest) temperature.   
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Note:  

Max/Min Temp point along with temperature value will be displayed on the image auto-

matically when you open the image. Choose this command again to delete the Max/Min 

Temp point from the image.  

 

 “Show Profile” Command  

 

Use this command to display temperature profile along a line, added to the opened image 

file by user. When moving the mouse along the line, a vertical line will appear and move 

together with the mouse, showing temperature of the point where the vertical line inter-

sects the user-defined line. This allows you to find any particular temperature located on 

the thermal image, which is read precisely from the profile. Icon + will show corresponding 

point on the line. 

 
Click the right mouse button on the line profile to view a window which brings up four 

commands: Copy, Setting, Save as, and Close. 

Choosing Copy command allows you to copy the rectangular coordinates and lines pro-

files to other applications.  

Choosing Setting command enables you to bring up the setup dialog box and change col-

ors and the background of the rectangular coordinates if you wish. Click OK Button to 

save changes and Cancel button to close without saving changes. 
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Save As command will allow you to save the profile to BMP or JPG image file.  

Clicking Close button will close the profile view window.  

Note:  

- Temperature reading and unit of the coordinates will change along with your choice of 

temperature degrees.   

- Clicking short button  in the toolbar can activate this command as well.  

 

„Isotherm” Command 
Use this command to add an isotherm to the opened image file for analysis. Tempera-

tures from the chosen range will be displaying additional, selected color.  

Isotherm settings dialog box will appear after choosing this command.  

 

Clicking Button  brings up the default isotherm. User can change its color, and limits 

by moving the scale pointers.  Clicking  Button again and repeating the above will add 

new isotherms and make changes to them as per requirements. Then pixels of the image 

file within the isotherm ranges are displayed in the isotherm colors. Choosing an isotherm 

name and clicking  button will delete the isotherm.  

„Histogram” Command 

This command includes two sub-commands as follows: Image Histogram - Use this 

command to display the percentage temperature distribution histogram of the opened im-

age file. Other Histogram: Use this command to display the percentage temperature dis-
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tribution histogram of the selected part of the thermal image - a line, polygon line, rectan-

gle, circle or polygon (if any). 

 

Image Histogram - After choosing this command, a dialog box showing the percentage 

temperature distribution histogram, divided into many ranges will appear:  

       

Moving the mouse cursor within rectangular coordinates of each histogram will display in-

formation on what is the percentage of the area that shares the selected temperature 

range in relation to the whole thermal image area. Clicking the right mouse button on his-

togram will bring up four commands window. Choosing Copy command  allows you to 

copy the rectangular coordinates and the histogram to other applications. Choosing Set-

ting command enables you to bring up the setup dialog box and change colors and back-

ground of the histogram. Choosing Save As command allows you to save histogram as 

BMP or JPG file. Close command will close the dialog box.  

Other histogram – This command is available after adding object to thermal image (line, 

rectangle, circle or polygon). After adding an object  to the opened image file, choosing 

this command will open a dialog box showing the object’s name and type. Click on the ob-

ject, and then click View button to display the histogram of the object.  
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Moving the mouse cursor within rectangular coordinates of each histogram will display in-

formation on what is the percentage of the area that shares the selected temperature 

range in relation to the whole thermal image area. Similarly to whole image histogram 

mode clicking the right mouse button on histogram will bring up four commands window 

(Copy, Settings, Save As, Close). 

Note:  

- Clicking  button in the toolbar can also activate Image Histogram command. 

- Viewing histograms of spots and delta-two spots added to the image file is not availa-

ble.  

 

Add Spot Command 

Use this command to add a spot to the opened image file for temperature measurement.  

After choosing this command, clicking left mouse button within image file will add a spot to 

it, with temperature of the spot and its number shown beside it and also in DataView Bar. 

 
 

You can change position and properties of the added spot as follows:  
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Move the spot 

Move the mouse pointer to the spot (more accurately to the symbol ), the mouse pointer 

will turn into a four-headed arrow with a + symbol. Click left mouse button to select it. It 

will turn into ,  Now the spot is movable. To move the spot, keep left mouse button 

pressed and drag the mouse to any desired place, then release the left button to confirm 

the place.    

 

Modify the spot property 

Move the mouse to the spot (more accurately to the symbol ), the mouse pointer will 

turn into a four-headed arrow with a + symbol, indicating that we can modify its properties. 

Double click on the spot to open Spot Property dialog box, where we can change its 

name, color, emissivity and choose whether or not the temperature should be displayed.  

 
 

Moving the pointer on transparency scale from left to right will allow the spot symbol  to 

change from being completely transparent to being completely solid. Click OK button to 

save the changes.  

Note: You can also activate Add Spot command by clicking  on the toolbar 

 

Add Line Command  

Use this command to add a line to the opened image file for temperature measurement.  

After choosing this command, keep left mouse button pressed and drag the mouse within 

the opened image file to add a line to it. Average, Max and Min temperature of the line will 

be displayed in DataView Bar. Number and average temperature will be shown beside the 

mouse when it moves along the line. You can change position, size, direction and proper-

ties of the line:  
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Move the Line 

Move the mouse cursor to the line . The mouse pointer will change its shape into crossed 

double-headed arrows. Click the left mouse button  to select it. Two small squares will ap-

pear on its two ends, indicating the line can be moved now. To move the line, keep left 

button of the mouse pressed and drag the mouse to any desired place, then release the 

left button to confirm the place. 

Change the line size 

Move the mouse cursor to the line . The mouse pointer will change its shape into four-

arrows cross. Click the left mouse button  to select it. Two small squares will appear on its 

two ends. Place the mouse cursor on one end of the line, keep left mouse button pressed 

and drag the mouse to a desired place, then release the left button to confirm the new 

place. Now the line size is changed. You can change the other end in the same way if 

needed. 

Modify the line property 

Double click left mouse button on the Line to open Line Property dialog box. Now you can 

change name, color, emissivity, etc. 

 
Moving the pointer on transparency scale allows the line to change from being completely 

transparent to being completely solid. Selecting Show min/ max position can indicate the 

spots (with symbols ×/*) having min/ max temperature on the line. Choosing Custom and 

changing emissivity value makes the program to recalculate and display temperature of 



   Sonel ThermoAnalyze® 30 

the line accordingly. Selecting Show temperature on image and then choosing any sub-

option will allow the program to display Average, Max or Min temperature of the line.  

After such modification, click OK button to save or click Cancel button to cancel the modi-

fication.  

Note: You can also activate Add Line command by clicking  on the toolbar 

 

Add Polygon Line Command  

 

Use this command to add a polygon line to the opened image file for performing thermal 

analysis of this polygon line.  

After choosing this command, drag the mouse to the spot where you want to start drawing 

the line. Click left mouse button continuously to confirm turning points. Double click left 

mouse button to add a polygon line to the image. All the line’s data (Min, Max and Aver-

age Temperature) will be shown in DataView Bar.  

You can change position, size and property of a Polygon line added to the opened image 

file. You can also change position of turning points of the Polygon Line.   

 

 
 

Move the polygon Line 

This function works identically to Move the Line command for single Line 

 

Change the polygon line size 

Moving mouse cursor over the polygon line will change it into crossed double-headed ar-

rows. Click left mouse button to select the line. Small rectangles will show up at the ends 

and at each turning point of polygon line. Move the mouse cursor over any of the rectan-

gles to change it into double arrow. Click and keep left mouse button pressed and drag 

the mouse to a desired place, then release the left button to confirm the new place of the 

turning point. This modification can be done for both line ends and for turning points as 

well. 
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Modify the polygon line property: 

This function works identically to Modify the line property command for single Line 

Note: You can also activate Add Polygon Line command by clicking  on the toolbar 

 

Add Rectangle Command  

Use this command to add a rectangle to the opened image file. It allows you to perform 

thermal analysis within its area.  

After choosing this command, keeping left mouse button pressed and dragging the mouse 

within an opened image file will draw a rectangle in it. Release the left mouse button to 

confirm the rectangle. All the temperatures ( Min, Max, Average) calculated for the rectan-

gle area will be shown in DataView Bar. Rectangle’s number and its average temperature 

will be displayed beside the mouse when it moves in the rectangle. 

 

 
 

You can change position, size and property of a rectangle added to the opened image file: 

 

Move the rectangle: 

Move the mouse into the rectangle, the mouse pointer will turn into crossed double-

headed arrows.  Click left mouse button to select it. Eight small squares will show up on 

its sides and vertexes, indicating that the rectangle can be moved now. To move the rec-

tangle, keep left mouse button pressed and drag the mouse to a desired place, then re-

lease the left button to confirm the place. 

 

Change the rectangle size: 

Click left mouse button within the rectangle to select it. Eight small squares will show up 

on its sides and vertexes, indicating that the rectangle can be edited now. Move the 

mouse cursor to any of the squares. Mouse cursor will change into double-headed arrow. 

Click and keep left mouse button pressed and start moving it around. This will stretch or 

shorten the rectangle in one dimension (when grabbing side squares), or will allow to 

change the whole shape of the rectangle (when grabbing corner squares). Release left 
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mouse button to confirm new shape. You can move each and every corner and side 

square  to change shape of rectangle.  

 

Modify the rectangle property: 

Place the mouse within the rectangle and then double click left mouse button to get Rec-

tangle Property dialog box. Now you can modify the property by changing items within, 

such as name, color, emissivity, etc.   

 

 
 

Moving the pointer on transparency scale allows four sides of the rectangle to change 

from being completely transparent to being completely solid. Choosing Custom and 

changing emissivity value makes the program to recalculate and display temperature of 

the area limited by the rectangle shape. Selecting Show min/ max position can indicate 

the spots (with symbols ×/*) having min/ max temperature on the rectangle.  

 

Selecting Show temperature and then choosing any sub-option will allow the program to 

display Average, Max or Min temperature within the rectangle.  

After such modification, click OK button to save or click Cancel button to cancel the modi-

fication.  

Note: You can also activate Add Rectangle command by clicking  on the toolbar 

 

Add Circle Command 

Use this command to add a round shape (circle or ellipse) to the opened image file, for 

performing thermal analysis within its area.  

After choosing this command, keeping left mouse button pressed and dragging the mouse 

within an opened image file will draw a round shape in it. Release the left button to con-

firm the shape.  

All the temperatures ( Min, Max, Average) calculated for the drawn round shape will be 

shown in DataView Bar. Number and its average temperature will be displayed beside the 

mouse when it moves within the circle. 
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You can change position, size and property of a circle added to the opened image file: 

 

 

Move the circle: 

Move the mouse into the circle, the mouse pointer will change into crossed double-

headed arrows.  Click left mouse button to select it. The circle will become surrounded by 

rectangular shape containing eight small squares. The object can be moved now. To 

move the circle, keep left mouse button pressed and drag the mouse to a desired place, 

then release the left button to confirm the place. 

Change the circle size: 

Click left mouse button in the circle to select it. The circle will become surrounded by rec-

tangular shape containing eight small squares. Move the mouse cursor to any of the 

squares. Mouse cursor will change into double-headed arrow. Click and keep left mouse 

button pressed and start moving it around to change the circle/ellipse shape. Release left 

mouse button to confirm new shape.  

Modify the circle property: 

This function works identically to Modify the rectangle property command for Rectangle 

shape.  

Note: You can also activate Add Circle command by clicking  on the toolbar 

 

Add Polygon Command 

Use this command to add any polygonal shape to the opened image.  

After choosing this command press left mouse button to start drawing a line, drag the 

mouse within opened image file and press left mouse button to confirm the first side of a 

polygon. Drag the mouse again to draw the other two sides of a polygon. Confirm each 

vertex by clicking left mouse button. Repeat the above to draw some more sides of the 

polygon. Double click on the last vertex of the polygon to confirm its final shape. 

Spots with Min and Max temperatures will be shown for the drawn Polygon.  
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You can change position, size and property of a polygon added to the opened image file: 

  

Move the polygon:  

Move the mouse into the polygon, the mouse pointer will change into crossed double-

headed arrows with a symbol . Click left mouse button to select it. Small squares will 

show up on its vertexes, indicating that the polygon can be moved now. To move the pol-

ygon, keep left mouse button pressed and drag the mouse to a desired place, then re-

lease the left button to confirm the place. 

Change the polygon size:   

Click left mouse button to select polygon. Small squares will show up on its vertexes, indi-

cating that the polygon can be edited now.  Move the mouse cursor to any of the squares. 

Mouse cursor will change into double-headed arrow. Click and keep left mouse button 

pressed and start moving it around to change the vertex position. Release left mouse but-

ton to confirm new shape. Use this method on each and every vertex to achieve desired 

shape and size of the polygon.   

Modify the polygon property:  

This function works identically to Modify the rectangle property and Modify the circle prop-

erty commands.   

Note: You can also activate Add Polygon command by clicking  on the toolbar.  

 

Add Delta Two Command  

Use this command to add a pair of spots to the opened image file, for which the tempera-

ture difference will be measured on-the-fly. After choosing this command, keep left mouse 

button pressed, drag the mouse within the opened image file and then release the left but-

ton. A pair of spots and the broken line between them will be confirmed. Two x symbols 

indicate the two spots. Temperature of the two spots and the temperature difference will 

be displayed in DataView Bar.  
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You can change position, size and property of these two points: 

Change size or location: 

Place the mouse cursor over one of the two spots, the mouse cursor will change into two-

headed arrow. Click left mouse button to select spot. To move it, keep left mouse button 

pressed and drag the mouse to desired place, then release the left button to confirm the 

place. 

Modify property: 

Place the mouse cursor over one of the two spots and then double click left mouse button 

to get DeltaTwo Property dialog box. Now you can modify the property by changing items 

within, such as name, transparency and emissivity of the spots.  

 
  

Moving the pointer on transparency scale allows the two spots to change from being com-

pletely transparent to being completely solid. Choosing Custom and changing emissivity 

value of the spots makes the program to recalculate the two spots temperature according-

ly.  

After modification, click OK button to save or Cancel button to cancel it.  

 

Add Combination Command 

Use this command to combine two existing areas to create a new object. Combination 

command contains five sub-commands: 
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Intersection Command 

Add two overlapping areas (like rectangle, circle, polygon) to the thermal image file and 

confirm one of them by clicking the left mouse button. Select Intersection command under 

Combination menu and move the mouse to the other area. Click the left mouse button 

again to bring out an intersection of the two areas for thermal analysis. Intersected object 

will become closed shape. 

   

Average, Max and Min temperature of the intersected object will be shown in DataView 

Bar. Number and average temperature will be shown beside the mouse when it moves 

over the intersection area.  

 

Subtract Command 

Add two overlapping areas (like rectangle, circle, polygon) to the thermal image file and 

confirm one of them by clicking the left mouse button. Select Subtract command under 

Combination menu and move the mouse to the other area. Click the left mouse button 

again to confirm subtraction of the two areas. Subtracted object will become closed shape 

for which you will be able to perform thermal analysis similarly as for any other objects.  

Average, Max and Min temperature of the subtracted object will be shown in DataView 

Bar. Number and average temperature will be shown beside the mouse when it moves 

over the subtract area.  

   

Merge Command 

Add two areas (like rectangle, circle, polygon) to the thermal image file and confirm one of 

them by clicking the left mouse button. Select Merge command under Combination menu 

and move the mouse to the other area. Click the left mouse button again to confirm the 
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merge of the two areas. The two areas don’t have to be overlapping for executing Merge 

command.  

   

Average, Max and Min temperature of the Merged object will be shown in DataView Bar. 

Number and average temperature will be shown beside the mouse when it moves over 

the merged area. 

 

Not Overlap Command 

If we apply this function to two overlapping objects (like rectangle, circle, polygon), we can 

merge these two objects, while the overlapping part will be subtracted.  

To perform this operation Select Not Overlap command under Combination menu and 

move the mouse to the other area. Click the left mouse button again to confirm execution 

of this command.  

   

Average, Max and Min temperature of the newly created object will be shown in DataView 

Bar. Number and average temperature will be shown beside the mouse when it moves 

over the object. 

Note: You can freely change position, size and properties of the created objects in the 

same way as described for simple objects like circle or rectangle.  

 

Decompose Command  

Select the object created as a result of using the commands described above, and acti-

vate Decompose under Combination menu to decompose the combination. 

Example: 

After choosing Decompose Command, R1 object, created by RT1 and A1 via Not overlap 

operation, is decomposed into RT1 and A1. Image below is illustrating this transition.  
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Delete Object Command  

Use this command to delete any object (a spot, line, rectangle, circle, polygon or a pair of 

delta-two spots) added to the opened image file if any.  

 
 

After choosing this command, move the mouse cursor over the object you want to delete, 

then the mouse pointer will change into × symbol, indicating you can delete the object. 

Additionally the object’s symbol will appear, below the × symbol. Click left mouse button to 

delete the object. To delete a pair of delta-two spots, move the mouse to either of the 

spots and click left mouse button to delete both of  them. 

Note: 

- You can also activate Delete Object command by clicking  on the toolbar.  

- The shape of mouse pointer varies on different objects to be deleted.  

- This command is also available for deleting the Max and Min temperature points cre-

ated automatically when opening thermal image.  

 

Delete All Objects Command  

Use this command to delete all the objects (spots, lines, polygon lines, rectangles, circles, 

polygons and delta-two spots) added to the opened image file if any.  

After choosing this command, all the objects will be erased from the opened image file.   

Note: This command is also available for deleting the Max and Min temperature points 

created automatically when opening thermal image.  
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3.3.5 Tools Menu  

 

Multi-isotherm command 

It contains two sub-commands: Setting and Apply. This command can divide the tempera-

ture range within an opened image into some small temperature ranges. Different tem-

perature ranges can be differently colorized. It is easy to see temperature distribution as 

per color. 

Setting command: Allows dividing temperature range within the whole thermal image. It 

can be done both manually and automatically. After selecting this command, the window 

below will come out:  

 

Add command: Allows to add a temperature range. After selecting this option new rec-

ord, with default color, will be added. You can select color and set min and max tempera-

ture as shown in the image below.  Change isotherm color by clicking on the color line. To 

change the range, click on the figures (set by default to “0” and “0” ), and type proper val-

ues by hand. 

 
After setting ranges click Save to apply changes. Isotherms will show up on the thermal 

image.  

Delete: Delete one, selected temperature range.  
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Auto Build command: Type in min and max temperature, set temperature range in Sin-

gle Spacing and click Build to averagely divide whole temperature range and build certain 

numbers of temperature ranges. 

 

 

Save command: Click Save, the setting will be applied. The infrared image will be dis-

played according to the setting.  

Apply command: Apply or cancel self-defined colorization for the opened image. Saved 

setting is remembered, even if it’s not used. Can be saved for future use with another 

thermal image.  

 

Image chart command 

This function is used to analyze the trend of highest and lowest temperature in multi im-

ages. It can not only analyze the highest and lowest temperature of each image, but also 

can analyze temperature fluctuation of the target point in time. There are two ways of dis-

playing trend: 1 – diagram or 2 - data. 

Open multiple images (at least two), click the Tool->Image chart, and you will see the be-

low dialog box: 
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“Select Image”: it is used to choose images for analysis.  

“Select Analyse Objects”: it is used to choose analysis target, such as the Maximum spot, 

Minimum spot or others. 

“Open File”: it is used to open“*.ird” file in which you saved previously analyzed set of mul-

tiple images.   

“Add Image”: it is used to add another thermal image 

“Open Image”: it is used to display selected thermal image as current window.  

“Save Image”: It is used to save multiple images analysis into“*.ird” file. 

“Built Chart”: It is used to generate chart, as shown in the image below: 

 
 

There is toolbar in the upper part of the window, allowing to draw temperature analysis 

chart in different ways:  

 
 

Depending on the chart type we selected, we can illustrate temperature analysis as fol-

lows:  

Line chart 

Vertical bar chart 

Horizontal bar chart 

Surface chart 

Point chart 
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Line chart: 

 

Surface chart: 
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Bar chart: 

 

Point chart: 

 

 
Chart can be also displayed in 3D. Click 3D button on the toolbar above to turn 3D mode: 

 
You can adjust the depth of 3D mode by moving the slider next to 3D icon (from left –

more depth, to right – less depth). You can also rotate chart by moving Rotate slider.  
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Examplary 3D charts:  

 

 

Rotated 3D chart: 

 



                                                                              USER MANUAL 45 

 

Following buttons allow to move, zoom in and zoom out chart: 

 
Counting above icons from the left: zoom in, zoom out, reset zoom, left shift, up shift, 

down shift, right shift. 

Examplary, zoomed out chart, with manually shifted temperature range is shown below: 

 

 
 

Below tool bar is to choose temperatures to be displayed and their color. 

 
 

Additionally, you can select points on the graph and their labels (also available in 3D 

mode): 
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You can scale chart automatically (it adjusts chart’s axis to fit in the whole chart on the 

screen), or manually (set min and max value on the scale). After selecting Show scroll 

mode, Auto scale mode is not available. 

 
Then you need to select the figure representing the number of points displayed on the 

chart on horizontal axis at one time. To see another points you need to use scroll bar. 
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Title: you can also type the name of the chart (in the title field): 

 
Remaining buttons on the toolbar have following meanings:  

 

3.3.6 View Menu 

 

Show visual Image,  

Use this command to display and hide the visual image 

 

Toolbar Command 

Use this command to display and hide the toolbar, which provides shortcuts to major func-

tions in the program. A checkmark appears next to the sub-menu Toolbar when the 

toolbar is displayed.  

 

Shortcut 

(Icon) 

Description 

 
Open Image Button 

 
Save Image Button 

 
Select Button 

 
Add Spot Button 

 
Add Line Button 

 
Add Polygon Line Button 

 
Add Rectangle Button 

 
Add Circle Button  

 
Add Polygon Button  

 
Add Delta-two Spots Button 

 
Delete Object Button 

 
Hand Button 
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Zoom In Button  

 
Zoom Out Button  

 
Show Histogram Button 

 
Show Profile Button 

 
Play Sound Button 

 
Palette Bar Button 

 
About ThermoAnalyse Button 

 
Specific Help Button 

Note: 

- You can refer to commands under menu bar to find detailed information of the 

shortcuts. 

- Specific Help Button means you can use this shortcut to get help for a specific menu 

item or toolbar button within the program. Choosing this shortcut and clicking a menu 

item or toolbar button you want to know more about will make the program to display 

the help content relevant to the object.      

 

Gauge Bar Command  

Use this command to display and hide gauge bar. A checkmark appears next to the sub-

menu Gauge Bar when the gauge bar is displayed. 

 

Status Bar Command 

Use this command to display and hide the status bar, which describes the action to be 

executed by the selected menu item or pressed toolbar button. A checkmark appears next 

to the sub-menu Status Bar when the status bar is displayed. 

 

Palette Bar Command 

Use this command to display and hide the palette bar. A checkmark appears next to the 

sub-menu Palette Bar when the palette bar is displayed. 

 

DataView Bar Command 

Use this command to display and hide the DataView bar. A checkmark appears next to 

the sub-menu DataView Bar when the dataview bar is displayed. 

 

Information Bar Command 

Use this command to display and hide the information bar. A checkmark appears next to 

the sub-menu Information Bar when the information bar is displayed. 
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Language Command 

Use this command to choose language from all languages available. 

Note:  

- Default is the default language of the operating system in your PC. If the program 

cannot recognize the language, the program will choose English as a default.   

- After you change the language, a dialog box will prompt you to restart the program to 

save the change. Clicking Yes button will close down, restart the program and change 

its language to be the one you chose. Clicking No button will remain the original lan-

guage. Language change will not be effected until you restart the program next time.  

 

3.3.7 Window Menu 

 

Cascade Command 

Use this command to arrange currently opened files in overlapped, cascade fashion.  

 

Tile Command 

Use this command to arrange currently opened files in non-overlapping windows, laying 

next to each other 

 

Window 1, 2,… Command 

The list of currently opened image files. Choosing a file from this list will make its window 

active.  

 

Bug Report Command  

Use this command to create and send us reports on the program bugs or problems,  you 

faced while using Sonel ThermoAnalyze. 

 

Note:  

Click Send Mail button to write and send an email to us to report the program bugs or 

problems. Click Create System button Info to create a document Back Info under the di-

rectory where you installed the program, showing information of your computer configura-

tion. After the document is generated, the program will automatically attach it to the email 
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you will send to us (warning! This may take several minutes). Click Open button to open 

this document. Click Open button under Picture to choose an IR, JPG, IRI or IMG image 

and attach it to the email you will send to us. Click System button to create and open doc-

ument containing System Information, displaying detailed information of your computer. 

You can edit and save the document as per requirements.   

 

Feedback Command 

Use this command to send your feedback about the program to us through email.  

 

Anout ThermoAnalyze Command 

Use this command to get information of the software version, copyrights, our website, etc.  
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4 Infrared Video 

4.1 General Information 

This chapter, describing Infrared Video mode, refers to the thermal imagers, manufac-

tured by Sonel S.A., that allow to record thermal video footage. Depending on the model, 

you can record infrared video by either connecting the camera to PC via USB cable, or by 

using external memory (SD card) inside the camera. All the required information on the 

availability of Infrared Video mode and how to record it, using your camera, can be found 

in Operation Manual of your thermal imager.  

When Infrared video is being recorded and saved directly into the hard drive of your com-

puter, you can analyze the footage both in real time, and also after recording is complet-

ed, by reading the data from the hard disk drive. Infrared video footage stored on SD card 

can be analyzed only after transferring it to computer. To transfer the data you have to in-

stall the driver supplied on CD along with the camera (described in  chapter 2).    

 

System requirements 

Operating system: Window 2000 or higher (IE5.0 or higher) 

Software: Microsoft® Office 2000 or higher 

Hardware:  

Processor Pentium 4 2.4G or Above 

RAM At least 512M 

Others Independent Graphic Card 

 

4.2 Main Menu 

Setup command 

Use this command to set a directory on the hard disks to store the infrared video, cap-

tured images and set other relevant information:  
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Film: set the directory path to save the video recordings (set by default to \IRVideo subdi-

rectory in the folder where the program is installed). 

Capture Saved: set the directory path to save the captured image 

Frame: set the frame rate of thermal images per second. The default value is 25/ second. 

Palette: set the palette to be used for the infrared video 

Kineskope rate: determines the sequence in which  the images will be saved, out of the 

whole video footage being captured (e.g. 1 – each frame; 5 – every 5th frame) . In some 

cases there is no need to record all frames, which will result in saving disc space. 

Update track: update the interval between track circles of each point 

 

Video Command  

Use this command to get infrared video directly from the camera( “Firewire Wideo...” 

mode), or open a video footage file previously saved on your hard drive (“Open video…”).  
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Device Video 

Before connecting the camera to PC, make sure it’s turned on and is under normal work-

ing status (menu must not be displayed on the screen). Connect the camera to computer 

using USB cable supplied with your camera. 

Note: When in Infrared Video mode, with the store location set to hard disk, you 

must remove SD card from the camera, and set store location to Uflash.   

After connecting to PC following dialog box will appear: 

 

 

Select your camera, press OK to confirm and below window will be displayed: 

 

 
You may start recording, pause video and operate shutter (depending on the camera you 

have) in the above real-time mode. 

 

Shortcuts you will find in video mode window:  
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 : Play infrared video. While recording, click this button to stop recording  

: Pause infrared video. Click again to resume the video from the place it was paused.   

: Make the video go forward by one frame when playing video.   

: Make the video go backward by one frame when playing video. 

 : Record video and save it in “IRVideo” folder, in the directory where the program is in-

stalled. Files are denominated automatically. Perform this command again, after stopping 

recording, to start recording to another file.  

F2: Operate shutter (selected cameras) 

F3: Near focus adjustment (cameras with autofocus mode) 

F4: Far focus adjustment (cameras with autofocus mode) 

 

Open Film 

Use this command to open the saved Video file. You can play this file and perform its 

analysis. 

 
Infrared video file will be opened as show below: 
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Shortcuts you will find in the upper part of the window:  

 : Play infrared video. While recording, click this button to stop recording  

: Pause infrared video. Click again to resume the video from the place it was paused.   

: Make the video go forward by one frame when playing video.   

: Make the video go backward by one frame when playing video. 

 

4.3 Video mode Menu  

4.3.1 Video Menu 

 

Palette Command  

Select a palette for infrared video. Nine palettes are available. 

 

Auto adjustment command 

Use this command to adjust image color automatically or manually.  

In Auto adjustment mode the software chooses optimal settings. In Manual adjustment 

mode user can map the temperature range of the selected palette by appointing max and 

min temperature. 

Note: 

Each and every adjustment of the range (check next command) will change the tempera-

ture range and will switch the image into manual mode. Execute this command to return to 

auto mode. 

 

“xxxxx” control command 

Allows to operate selected camera through the software as below: 
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Calibration (F2) Select this option or press F2 button on your keyboard to perform 

calibration of the camera.  

Near Focus (F3) - Press F3 continuously to adjust near focus, stop adjusting by releasing 

the button 

Far Focus (F4) - Press F4 continuously to adjust far focus, stop adjusting by releasing the 

button 

The camera allows long time (limited by hard disk space), high resolution recording , 

which is suitable for both medical (body temperature measurement) and industrial applica-

tions.  

Video capture command  

When playing infrared video, use this command under Video Menu or Press Ctrl + T to 

capture the current image.  

 
Captured image can be: 

- Saved as .IRI or .JPG file in selected directory. 
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- Opened as a new file (.IRI or .JPG) 

- Saved and then opened  

Note:  

- For KT family cameras the file format is .JPG 

- Captured images are stored in the pre-set path (File menu -> Setup): 

-  
 

Play command  

Use this command or press  to play infrared video. Press again to pause.  

 

Pause Command  

 

Use this command or press  to pause infrared video. Press again to resume the video.  

Frame Forward command 

Use this command or press  to make the video go forward by one frame when playing 

video. 

 

Frame Backward command 

Use this command or press  to make the video go backward by one frame when playing 

video. 

 

Record command  

Use this command or press  to Record video and save it in the folder on your hard disk 

drive. By default it is in the directory where the program is installed. Files are denominated 

automatically. Perform  again to stop recording.  

Note: Saved video file can be opened with the software for further analysis.  

Go to Open film under Video sub-menu in File menu, to open saved video file.  
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4.3.2 Measure Menu 

Temp Unit command 

 

You can choose Celsius or Fahrenheit degrees as temperature unit, as below: 

 
 

Show Max Temp Pos 

 

After choosing this command, the symbol × will appear immediately in the image file to in-

dicate where the point of max temperature is located, with the temperature value dis-

played beside the spot. 

 

 

Show Max Temp Pos 

 

After choosing this command, the symbol + will appear immediately in the image file to in-

dicate where the point of min temperature is located, with the temperature value displayed 

beside the spot. 



                                                                              USER MANUAL 59 

 
 

Show Track View 

 

Use this command to display  diagram, being drawn in real time, representing tempera-

ture fluctuation of spot, lines or areas added to the infrared video.  

For spot, it will display its current temperature. For lines or areas, it will display the aver-

age, min or max temperature of the selected lines or areas. 

Choose this command after adding object defining the area, for which the temperature 

analysis will be performed.  

 

 
 

Click on the object to open up a window, where you can change the line color and trans-

parency of selected object.  
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Double click on Track View window to open dialog box, where you can change its settings: 

background color, color of diagram axes, min and max temperature on axes. Click OK 

button to save changes or Cancel Button to close the window without saving changes 

 

Note: Chart line shares the same color with the object it represents. Thanks to the fact 

that chart line color depends on the object color, you can analyze the change of tempera-

ture of many spots and areas in one window.  

Press F11 to save the current TrackView window as JPG file in the directory where the 

captured pictures of the infrared video are stored. 

 

Other Commands 

The other commands such as Histogram Command are the same as the measurement 

commands for the static thermal image. Isotherm Command is not available in video 

mode. 

 

4.3.3 Tools Menu 

 

Temperature Alarm Command 

Audible alarm sounds whenever temperature set point is exceeded.  

Alarm Setting:  set the temperatures, excess of which activates an alarm. Set Max value, 

to activate an alarm when the temperature is higher than selected value. Set Min value to 

activate an alarm for temperatures below the selected value.  
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You can record thermal image whenever the alarm is activated. Images will be saved in 

the directory where the captured pictures of the infrared video are stored. Recording will 

continue as long as the temperature is exceeded, according to the set interval.  

Enable Alarm(Ctrl+A): Choose this command to active the alarm function. (√ mark will 

appear). 

 

 
 

Note: Sound alarm file is named as “Alarm.wav”. This file is located in the directory where 

the program is installed. User can change the alarm sound freely. To replace your alarm 

sound copy any .wav file into the directory and change its name to “Alarm.wav”. 

 

Auto Capture Command 

This command allows capturing pictures automatically. There are 2 options: 

Setting: set auto capture interval, based on time or frame frequency: 

 
Enable Auto Capture (Ctrl+A): Choose this command to active the auto capture function, 

with parameters as chosen in setting window (√ checkmark will appear). 
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Record Analysis Data Command 

Use this command to export real-time temperature data analysis results into .txt file or 

chart. The data can be displayed as point, line or surface chart according to selected time 

intervals.  

Click  on the opened video window bar or select Menu “Tools” and then “Record 

Analysis Data” to run this command. A dialog box will display as below: 

 
 

There are two analysis modes – File and Charts 

 First select the objects to be analyzed such as spot, line or area, then set the tem-

perature analysis interval (time or frame). Select “File” and click “Start” button when 

infrared video is played (or recorded in real time ) and the temperature information of 

analyzed objects will appear in Data List – date, time and corresponding tempera-

tures of the objects. 
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When “Auto Refresh” is selected, the data list will display the newest information. When 

“Auto Refresh” isn’t selected, click “Refresh” to update the results. Click “Previous” to go 

to the previous page of report, click “Next” to go the next page of report.  

Click “Stop” to stop the data recording. 

All the data displayed in Data List window is being saved automatically as txt file. Name of 

the file is assigned automatically as IRObjectXXXXXXXXXXXX.txt (“XXXXXXXXXXXX” is 

replaced by date and time of data recording). The file is saved in the directory where the 

captured pictures of the infrared video are stored. You can open the file in the program, in 

Analyzed Object Data window. Click Open to open the file in the default text editor of your 

operating system: 

 
 

Click “Exit” to exit this command 
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When selected analysis mode is Chart, after recording the data, results will be displayed 

as a chart. Similarly to text mode analysis, you need to choose object or objects (spots, 

lines, areas) for which the temperature reading will be performed. Select “Charts” and 

click „Start” button. When video is being played or recorded in real time, the process of 

collecting the data and chart drawing will begin.  

 
 

Temperature charts are drawn gradually as the data recording process progresses.  

   
 

In auto mode, in order to picture the temperature change process in the best possible 

way, the temperature range is selected automatically.   

X axis updates itself as the time goes by and more readings are being displayed.  
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Status bar, at any given time, shows number of the point which is currently being read.   

 

 
User can make use of following settings: 

Interval: reading sequence based on time or frame 

Scales: select “Automatic” and the temperature scale of Y-axis will be set automatically. If 

not selected, the Min and Max value of Y-axis can be set by user. 

Xcount: set the number of samples which will be displayed in single chart window. 

3D: display the chart in 3D mode. The slide bar is used to adjust the depth of 3D effect. 

 
 

Show Point: display the point position in the chart according to interval. 



   Sonel ThermoAnalyze® 66 

 

 

Show Marks: display the temperature of each registered point 

 
 

Note: Chart colors for different object types are selected automatically 

 

4.3.4 View Menu, Window Menu, Help Menu 

 

Refer to View Menu, Window Menu, Help Menu for image analysis. 
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5 Creating Report with Microsoft® Word 

General information 
Sonel ThermoAnaliyze® allows to create reports out of the registered thermal images by 

working together with Microsoft® Word. When creating a report, the software menu is up-

graded by some specific elements from Microsoft ® Word, containing the appropriate 

commands to create the report. You can use them to insert all the information of the im-

age file for which a report will be created into the report, and then edit the report with other 

Microsoft® Word menus. 

5.1 Using the menu 

Choose report->word->new under Report command in File menu. A report as shown be-

low will open in the program window. 

 
Four menus of the program appear in the Microsoft® Word menus: File, Report, Windows 

and Help. Additional commands in those menus  refer only to the created report.  Descrip-

tion of the commands below. 

5.1.1 File menu 

Save command 

Save the currently edited report under existing, or new file name.  

 

Print command 

Print the current report 

 

Exit command 
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Exit the program. Before closing you will be asked to save the changes that were not 

saved. 

5.1.2 Report Menu 

Commands under the Report menu carry out most of the basic procedures to create a re-

port.  

Select Image command 

Choose the thermal image that will be used in the report. You can choose one from all the 

images currently opened in the program. If there is more than one image opened, the se-

lection window will appear, allowing to select the thermal image that will be used in report. 

Once selected, press OK, then the report will be created on the basis of selected images 

 

Note: the program selects automatically if there is only one  thermal image opened.  

You can also choose images from an additional toolbar that appears when you create a 

report: 

 

Insert Thermal Image command 

Insert the selected thermal image into the report. If there is more than one image currently 

opened in the program, this command is available only after selecting  thermal image by 

using Select Picture command.  

If there is only one opened image, or you have already made selection with “Select…” 

command, click on the image to insert it into the report.  

Note: You can also activate Select Image command by clicking  on the toolbar. 

 

Insert Photo command 

insert the visual image saved together with the selected thermal image or other visual im-

ages stored in your computer (if any) into the report. After choosing this command you 

need to make selection (in the dialog box as shown below): 
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Choose ‘Y’ to insert other visual image (not the visual ones for the selected thermal im-

age) into the report. 

Choose “N” to insert the visual image of the selected thermal image into the report 

Choose “Cancel” to exit Insert Photo Command 

Note: You can also activate Insert Photo command by clicking  on the toolbar. 

 

Insert Profile Command  

Use this command to insert profiles of lines added to the selected thermal image (if any) 

into the report.  

Note: You can also activate Insert Profile command by clicking  on the toolbar. This 

command becomes active only after selecting image (Select Image command) 

 

Insert Property Command  

Use this command to insert properties of the selected thermal image into the report. 

Choose Property Table sub-command under this command to insert table containing all 

the properties of the selected thermal image into the report. Selecting other sub-command 

inserts only the value of the selected property into the report.  

Note: Clicking shortcut icon  in the toolbar can activate this command as well. 

You can choose whether to insert all the data or a specific item value to the report from 

the sub-options by clicking next to property.  

This command is not active until a thermal image is selected (Select Image command).  

  

Insert Histogram Command  

This command includes two sub-commands as follows:  

Image Histogram: Use this command to insert histogram of the selected thermal image 

into the report.  

Other Histogram: Use this command to insert histogram of the object (a line, rectangle, 

circle or polygon) added to the selected thermal image (if any) into the report.  After 

choosing this command, below window will appear, allowing you to make choice. Select 

the object and click View, to add the object’s histogram into the report.  

 

Note: Clicking short icon  in the toolbar can activate this command as well. You can 

choose whether to insert the image histogram or other histogram by clicking  button on 

the right. This command is not active until a thermal image is selected (Select Image 
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command).  

Insert Analysis Result Command  

Use this command to insert the table containing the analysis results of all the objects (a 

spot, line, rectangle, circle, polygon or a pair of delta-two spots) added to the selected 

thermal image (if any) into the report.   

Note: You can also activate Insert Analysis Result command by clicking  on the 

toolbar. This command is not active until a thermal image is selected (Select Image com-

mand).  

Insert Analysis Command  
Use this command to insert the table containing the analysis results of the selected ob-

jects (a spot, line, rectangle, circle, polygon or a pair of delta-two spots) added to the se-

lected thermal image (if any) into the report.   

After choosing this command, Insert Analysis Table dialog box will appear to prompt you 

to choose the object whose data will be inserted into the report. Choose the object and 

click OK button to add its data into the report.  

 
 

Note: This command is not active until a thermal image is selected (Select Image com-

mand).  

After using these command, all the information regarding the selected thermal image will 

be included in the report. You can add more information and edit it with other Microsoft
 

Word commands if necessary. After editing, choose Save command under File menu to 

save the report.  

5.1.3 Window Menu 

In addition, the expanded "Window" menu will also display on the list of all open windows, 

both opened thermal images and report windows. Choose any of them to make the se-

lected window active. 
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5.1.4 Help Menu 

Microsoft Word Help command 

This command redirects to MS Word help window 

 

5.1.5 Toolbar description 

The toolbar provides shortcuts to major functions in the report.  

Shortcut  Description  

 Select Thermal Image Button  

 
Insert Thermal Image Button  

 
Insert Photo Button  

 
Insert Profile Button  

 Insert Analysis Result Button  

 Insert Property Button  

 Insert Histogram Button  

All above buttons were described in details in advance, as Report menu commands 

 

5.2 Creating a Report 

Choose report->word->new. A report as shown below will open in the program window. 

 
 

Input the report title and other general information to the blank report. Choose Open Im-

age command under File menu to open a thermal image. If you have opened several 

thermal images, choose Select Image command to select one of them. Choose Insert 

Thermal Image command under Report menu to insert the thermal image to the report. 
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If you have opened one thermal image before creating a blank report, the program will au-

tomatically create the report for this thermal image. In this case, you can directly choose 

Insert Thermal Image command to insert the image without re-opening it.  

Choose Insert Photo command under Report menu to insert the visual image saved to-

gether with the selected thermal image or other visual images stored in your computer (if 

any) into the report. 

Choose other commands under menu Report to insert all the relevant information to the 

report. Then you can edit the report with other Microsoft Word menus and commands. 

Choose Save command under File menu to save the report as MS Word file. The saved 

report can be edited later, without having to use Sonel ThermoAnalyze program.  

 

5.3 Creating an Inspection Report with The Report Wizard   

General information 

Before you begin creating a report using the report Wizard, you must create a report tem-

plate (a *.dot file), and the thermal image on the basis of which the report will be created, 

must be selected. 

Note:  

- The program is supplied with 3 kinds of report templates (called ReportTemplate1.dot, 

ReportTemplate2.dot and ReportTemplate3.dot) for your basic use. Also you can cre-

ate customized report templates. You will find detailed description on how to create 

customized report template in the next section. 

- ReportTemplate1, ReportTemplate2 and ReportTemplate3.dot are under the directory 

where you installed the program. If you did not change the default directory during in-

stallation, you will find it under:  

C:\Program Files\Sonel ThermoAnalyze\language\english\Templates. 

- Using a template when creating a report at any time, you can select one of the tem-

plates as the default report template. You can use other templates than the ones 

supplied with the program. 

5.3.1 Creating a Report 

Choose Report Wizard sub-command under Report  command in File menu. A dialog box 

will appear to prompt you to select a report template before creating the report. 
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Follow the report wizard (5 steps in total) to create the report. In Step 2 of the wizard, you 

can edit the properties of selected template (e.g. by specifying the place where measure-

ments were done or selecting person who performed the measurements), by double click-

ing on it and then editing its property in the opened dialog box. 

 
 

Next step is to select the thermal image(s) you want to input into the report. You can use 

multiple thermal images in one report. 
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Step 4. After selecting thermal image file, you will see a preview window of visual and 

thermal images. By double-clicking on the file name you can change the visual image - 

you can insert any image in place of the visual image taken along with the thermal image.   

 

After clicking "Next", the program will ask you to save the report in the selected directory. 

Choose "Save" and new window will appear. In this window you can make a choice: just 

save the report, save and print or save it and open the report again. 
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When re-opening the report, you can edit it by using the commands of MS Word and addi-

tional buttons, allowing you to insert objects associated with the thermal analysis. 

 

5.3.2 Creating Report based on a Customized Report Template 

 

General Information 

There are exemplary templates installed in the program by default. Basing on them, you 

can create your own customized templates according to your specific requirements.  

Note: Creating a report template requires skill in creating document templates in Mi-

crosoft® Word. For more information, please refer to your Microsoft® Word documenta-

tion or the Microsoft® Word online help.  

Choosing a report template is only required when creating a report using the report wiz-

ard. The command Report wizard is unavailable unless a thermal image has been opened 

in the program window. 

 

Creating a Report Template based on the standard existing Template 

The easiest way to create new, customized template, is by modifying existing one. You 

can make use of the existing infrared objects already included in the template and save a 

lot of time compared to creating a template from scratch.  

Note: 

- You can modify any information in the template file ReportTemplateXX.dot (XX means 

1,2, ...), but it is advisable not do modify information included in <##> (e.g. 

<#PageStart#>), which is automatically input by the program and also predefined type 

fields, used by program.  

- After saving changes made in ReportTemplateXX.dot file, the program will always utilize 

this new version to create reports. You cannot resume its original information unless you 

reinstall the program. 

- You can freely name created .dot (templates) files, but the folder must contain one 

file named ReportTemplate1.dot 

 

Creating a Report based on the modified ReportTemplateXX.dot 

Find the place where ReportTemplateXX.dot is located. Default directory is:  

C:\Program Files\Sonel ThermoAnalyze\language\english\Templates. You should open 

template file either by using MS Word, or by using Windows explorer (click left mouse but-

ton and choose Open to open it).  Please never try to double click ReportTemplateXX.dot 
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to open it. Double clicking a template file will open a new Word file (*.doc) in MS Word, ra-

ther than opening the selected template file (*.dot).                         

Save new template file as ReportTemplateXX.dot or use any other name. 

On the basis of the modified template, you can create a report in the same way as on the 

basis of the templates provided with the program. 

 

Creating Customized Report Template 

A report template file is essentially a Microsoft® Word template file. There are two ways to 

create such template file.   

1. Create a new Microsoft® Word document and then save it as template file (*.dot) 

- Create a new Microsoft® Word file 

- Open and edit it as per your requirement 

- Choose Save As command to save it as a template file.In the dialog box save as, enter 

the file name, choose Document Template as the file type and then choose a directory to 

save it.  

- Remember where you saved it so that you can easily find it when choosing templates to 

create reports. The default directory for Microsoft® Word Document Template files is the 

folder where Microsoft® lies in your operating system.  

2. Copy the template ReportTemplate.dot, and save the file modified as per your require-

ment.  

- Select ReportTemplate.dot, copy and paste it in a folder where you want to store it. A 

template file named Copy of ReportTemplate.dot will be created.  

- Rename it if you wish 

- Select the file, click right mouse button and choose Open   

- Modify its content as per your requirement.  

- Choose Save command to save it in the original name or Save As to save it as a new file 

under a new name. And save it in selected directory.  

- Remember where you saved it so that you can easily find it when choosing templates to 

create reports.Default directory is:  

C:\Program Files\Sonel ThermoAnalyze\language\english\Templates. To save the original 

file use different name for your customized template report file.  

Now, the new report template is available for creating reporta based on it.  

Note:   

- You can save new templates in the same folder or in any different folder. If you want to 

save it in a different folder, you need to go to the folder to choose it when you creating re-

ports.  

- You can set up the directory where to save report templates using Setup command un-

der File menu. The program will automatically go to the directory to find a template when 

creating a report. 
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Creating a Report based on the New Report Template       

Choosing a report template is only required when creating a report by using the Report 

Wizard.       

- Open one or several thermal images.  

- Choose Report Wizard sub-command under Report command in File menu  

- A dialog box will appear to prompt you to select a report template before creating the re-

port. Now go to the directory where you save the templates and choose one you want to 

use.  

 
Follow the steps of Report wizard to create a report (This procedure is described in details 

in the previous chater called Creating an Inspection Report with The Report Wizard).  

Note: 

Create report in Excel format is also available. Detailed processes are exactly the same 

as creating report in Word format. 
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6 Emissivity 

 

What is emissivity? 

The concept of emissivity is inextricably linked with the physical model of a black body. It 

is a term used in physics, determining the object absorbing the whole electromagnetic ra-

diation it’s exposed to, whatever the temperature of the body, the angle of incidence and 

spectrum of the incident radiation. The absorption coefficient for such a body is equal to 

one for any wavelength. 

For the blackbody model we take an enclosure with irregular interior, covered with soot, 

with only one small hole leading inside. The radiation coming inside by this hole is reflect-

ed many times by the walls, which results in the entire radiation being absorbed. Thus, the 

parameters of the radiation coming out from the inside of a black body depend only on the 

temperature of its interior. 

A small hole in such an enclosure only affects this radiation level very slightly. The area of 

the hole should not exceed 5% of the area of the walls of the enclosure, when the radia-

tion passing through the hole is within about one part in a thousand of the blackbody radi-

ation level defined by the wall temperature. Such a device is fairly easy to build and forms 

the source on which all thermometers are calibrated. 

 

A real object's surface always emits less radiation than a black body of the same tempera-

ture would. Radiation emitted by surface to Radiation emitted by black body ratio is called 

emissivity. 

 

 
 

 

How to deal with emissivity? 

If you read the temperature ignoring the phenomenon of emissivity, the read temperature 

will be lower than the actual temperature. This temperature is known as the "apparent" or 

"brightness" temperature of the surface. If the emissivity is constant, this temperature ris-

es and falls in exactly the same way as the true temperature.  

 

Because we are interested in getting to know the real temperature, we have: 

 

Actual output = ε x output when measuring blackbody 

 

To obtain the true surface temperature we must divide the actual output by the emissivity 

value ε before we convert to temperature. 

       Radiation emitted by surface with specified 
temperature 

Radiation emitted by black body with the same  
temperature 

Emissivity  = 
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It is therefore necessary to know the value of the emissivity of the measured surfaces. 

There is a vast amount of data available; unfortunately much of it is confusing because 

substantially different values are quoted. This is because emissivity depends upon: 

- Surface condition - roughness and oxidation 

- Temperature (also ambient temperature) 

- Angle of view 

- Infrared Wavelength 

For materials with smooth, clean (unoxidised) surfaces, emissivities are usually in the 

range of 0.05 to 0.50 and are usually very wavelength dependent, being higher at shorter 

wavelengths. The appropriate settings for the KT-160 Thermal Camera are given in the 

following table. It must be remembered that these are only guideline figures. They can be 

substantially increased if the surface is rough or even slightly oxidised. The values quoted 

for oxidised metals assume that the metal is heavily oxidised. Thin oxide layers will give 

an emissivity value between this and the value for an unoxidised surface. 

Adjusting emissivity value for the object or the whole thermal image, you need to take real 

ambient temperature value into consideration when performing measurements. 
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6.1 Typical Emissivity Values 

aluminum ................................................ 0.05 

aluminum Rough ..................................... 0,07 

Aluminum oxidized .................................. 0,25 

asphalt .................................................... 0,90 

asbestos board  ...................................... 0,96 

asbestos (fiber) ....................................... 0,78 

akelite ..................................................... 0,93 

bronze: dull ……………………………….. 0,22 

bronze: polished………………………….. 0,10 

bronze: rough …………………………….. 0,55 

brick: glass., rough……………………….. 0,85 

brick: fireproof, rough…………………….. 0,94 

cement…………………………………….. 0,54 

cement (concrete)………………………… 0,90 

chrome……………………………………...0,15 

chrome polished………………………….. 0,10 

tin……………………………………………0,09 

zinc………………………………………….0,05 

brick red………………………………….…0,93 

paint: oil…………………………………….0,94 

clay: fired……………………………..…….0,91 

clay………………………………………….0,40 

graphite……………………………………. 0,85 

ground: frozen…………………………….. 0,93 

rubber……………………………………….0,93 

cobalt………………………………………. 0,18 

quartz………………………………….…….0,93 

lacquer white..…………………………….. 0,87 

lacquer polished black…………………… 0,87 

lacquer dull black…………………………. 0,97 

lacquer silver……………………………… 0,31 

ice………………………………………….. 0,97 

magnesium………………………………...0,12 

copper: oxidized………………………….. 0,65 

copper: oxidized black…………………… 0,88 

copper: polished………………….………. 0,07 

copper: polished annealed………..0,01.. 0,02 

brass………………………………………. 0,10 

brass: oxidized……………………………. 0,61 

nickel : polished………………………….. 0,05 

lead: polished…………………………….. 0,08 

lead: grey…………………………………. 0,28 

lead: oxidized………………………………0,63 

paper white……………………………….. 0,90 

paper black glossy……………………….. 0,90 

paper black dull…………………………… 0,94 

paper: tarred………………………………. 0,92 

plastic: black………………………………. 0,95 

platinum……………………….…………… 0,10 

porcelain: glazed…………...…………….. 0,92 

mercury………………………………….… 0,10 

lampblack……………………………...….. 0,96 

silver……………………………………….. 0,03 

steel: galvanized………………………….. 0,28 

steel: oxidized…………………………….. 0,88 

steel: rolled freshly……………………….. 0,24 

steel: rolled………………...……………… 0,56 

steel: rough……………..………………… 0,96 

steel: rusty red……………………………. 0,69 

steel nickeled……………………...……… 0,11 

glaze……………………………………….. 0,90 

glass……………………………………….. 0,92 

glass dull…..……………………………… 0,96 

snow……………………………………….. 0,80 

tape insulation…………………………….. 0,95 

fabric……………………………………….. 0,85 

titanium………...………………………….. 0,30 

carbon……………………………………… 0,90 

charcoal powder………………………….. 0,96 

tungsten…………………………………… 0,13 

tungsten: oxidized………………………… 0,11 

gold………………………………………… 0,02 

iron: glossy…………...…………………… 0,16 

iron: heat rolled…………………………… 0,77 

iron: oxidized……………………………… 0,74 

iron: polished……………………………… 0,23 

iron and steel: oxidized…...……………… 0,85 

cast: raw casting…………………………. 0,81 

cast: polished………………..…………… 0,21 
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